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Keep it simple

Github repo as a single point of entry.
Slides per topic / lesson, links into repo.
Provide short, focused, working examples.

Simple to get started, possible to learn more.


https://github.com/tamberg/fhnw-iot
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loT Engineering
Module iot by @tamberg for FHNW.

Slides and code examples

. Syllabus

. Introduction to the Internet of Things
. Microcontrollers, Sensors & Actuators
. Sending Sensor Data to loT Platforms
. Internet Protocols, HTTP and CoAP

. Local Connectivity with Bluetooth LE

. Raspberry Pi as a Local loT Gateway

. Messaging Protocols and Data Formats
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. Long Range Connectivity with LoRaWAN

©

. Dashboards and Apps for Sensor Data
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. Rule-based Integration of IoT Devices

-
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. Voice Control for Connected Products

-
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. Raspberry Pi as an loT Edge Device

-
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. From Prototype to Connected Product

-
B

. Assessment

-
o

. Demo Day
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Code Blame Raw D & 2 ~

Lesson 3: Sending Sensor Data to loT Platforms

¢ Slides

Examples

e ESP8266_WiFiClient.ino

e ESP8266_WiFiClientSecure.ino

e ESP8266_WiFiClientSecureCaCert.ino

o ESP8266_WiFiClientSecureFingerprint.ino
e ESP8266_WiFiMacAddress.ino

e ESP8266_WiFiNtpClient.ino

e ESP8266_WiFiSetup.ino

¢ ESP8266_WiFiTimeClient.ino

Hands-on

- s s on lossond
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IoT reference model
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ESP8266 Wi-Fi setup

#include <ESP8266WiFi.h>

void setup() {
Serial.begin(115200); // for debug output

WiFi.mode(WIFI_STA); // _AP|_AP_STA|_OFF

WiFi.begin("MY_SSID", "MY_PASSWORD"); // TODO

while (WiFi.status() '= WL_CONNECTED) {
delay(500) ;

'
Serial.println(WiFi.localIP());

}
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& > C @& https://github.com/tamberg/fhnw-iot/blob/master/03/Arduino/ESP8266_WiFiSetup/ESP8266_WiFiSetup.ino CamAx X &2 %0 ‘

°
= O tamberg |/ fhnw-iot Q Type (/) to search Dol +~- O N1 B8 ‘
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(9 ¥ master ~ fhnw-iot / 03 / Arduino / ESP8266_WiFiSetup /| ESP8266_WiFiSetup.ino (& Q Gotofile t
‘ tamberg Update. 419d4da - 2 years ago <) History

Blame 19 lines (16 loc) - 459 Bytes Raw D & 2 ~ [0

1 #include <ESP8266WiFi.h>

2

3 const char xssid = "MY_SSID"; // TODO

4 const char xpassword = "MY_PASSWORD"; // TODO
5

6 void setup() {

v Serial.begin(115200);

8 Serial.print("\nConnecting to network ");

9 Serial.println(ssid);

10 WiFi.mode(WIFI_STA); // or WIFI_AP, WIFI_AP_STA, WIFI_OFF
11 WiFi.begin(ssid, password);

12 while (WiFi.status() != WL_CONNECTED) {

13 delay(500);

14 }

15 Serial.print("Connected, IP = ");

16 Serial.println(WiFi.localIP());

17 }

S ,
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<> Code () Issues 6 I Pullrequests &I Discussions

0® % master ~ fhnw-iot/03/Arduino/ 3

§ tamberg Update.

z
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ESP8266_ThingSpeakWiFiClientSecure
ESP8266_ThingSpeakWiFiClientSecureWithTime
ESP8266_WiFiClient

ESP8266_WiFiClientSecure
ESP8266_WiFiClientSecureCaCert
ESP8266_WiFiClientSecureFingerprint

ESP8266_WiFiMacAddress

ESP8266_WiFiNtpClient

® Actions

Q Type /) to search

3 Projects

Last commit message

Update.
Update.
Update.
Update.
Update ESP8266_WiFiClientSecureCaCert.ino

Update.

Added example code.

Cleanup.
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M wiki @ Security [~ Insights 3 Settings

Q Gotofile t Add file ~

3e75fc6 - 10 months ago  ¥Y) History

Last commit date

2 years ago
2 years ago
2 years ago
2 years ago
10 months ago
10 months ago
4 years ago

4 years ago




Provide support

Hardware kit with MCU, basic sensors, actuators.
Curated Github Wiki for details and troubleshooting.
Github issues to report bugs, typos, specific fixes, etc.

Github Classroom for individual, private copies of a repo.
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IoT Hardware for CS Bachelor Students

CC BY-SA thomas.amberg@thnw.ch, 24.01.2019

Abstract

Options and thoughts around Internet of Things hardware for computer science bachelor students.

Introduction

The following options were collected during the evaluation of IoT hardware for the course IoT
Engineering [0] at FHNW, the University of Applied Sciences and Arts Northwestern Switzerland.

[0] https://www.thnw.ch/de/studium/module/0280188

A simple reference model

A simple IoT reference model [1] is used to identify the main technical parts of connected products:

Device (with Sensors & Actuators) <-> (Edge) Gateway <-> (Cloud) Backend <-> Client (Apps)

[1] http://www.tamberg.org/iotmark/2018/ConnectedProductReferenceModel.pdf

Learning objectives
The course IoT Engineering [0] introduces bachelor students to IoT, covering the following topics:
- Architecture of IoT systems and Internet-connected products

- Prototyping with beginner hardware, sensors and actuators
- Connectivity options for short and long-distance data transmission
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loT Engineering Wiki

The Wiki contains tools and hardware setup instructions which are referenced by lessons.

Found a typo or something missing? Submit an issue.
Development tools

Development environment

e Arduino
¢ VS Code

Command-line tools

o curl
o mqtt

e coap

Network analysis

e Wireshark

Hardware

~ Pages @B

Find a page...

v Home
loT Engineering Wiki

Development tools
Development environment
Command-line tools
Network analysis

Hardware
Linux computers
Microcontrollers
Extensions
Grove sensors
Grove actuators
Grove adapters
Various

loT platforms

Resources
loT books

Javascript

» Arduino
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Hardware

v

Arduino

v

Command Line Tools

v

Feather Huzzah ESP8266

v

Feather M4 Express

» Feather nRF52840 Express
> FeatherWing RFM95W

» Grove Actuators

» Grove Adapters

» Grove Sensors

> loT Books

[ el Bl bl e
[ N e e -} U

» |oT Platforms

i FIEIEIP \ » Raspberry Pi Zero W
- o

m‘; ] » Various

» VS Code

Linux computers

¢ Raspberry Pi Zero W with Wi-Fi & BLE

\ + Add a custom sidebar )
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Linux computers

¢ Raspberry Pi Zero W with Wi-Fi & BLE

Microcontrollers
¢ Feather Huzzah ESP8266 with Wi-Fi
o Feather nRF52840 Express with BLE
Extensions

¢ FeatherWing RFM95W LoRaWAN

Grove sensors

¢ Button

¢ Light Sensor v1.2

¢ Rotary Angle Sensor

e Temperature & Humidity Sensor

¢ Ultrasonic Ranger

Grove actuators

¢ 4-Digit Display
e Buzzer
e Chainable RGB LED

T an% x&z»O§

» VS Code

+ Add a custom sidebar

Clone this wiki locally

https://github.com/tamberg/fhnw-

&
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Feather Huzzah ESP8266

Thomas Amberg edited this page on Sep 28, 2019 - 74 revisions

Buy

o https://www.adafruit.com/product/3213 (w/ stacking headers, ~20$)
Code

Arduino

Setup (step-by-step)

o https://learn.adafruit.com/adafruit-feather-huzzah-esp8266/using-arduino-ide

Setup (for experts)

¢ USB Driver for macOS, Windows: http://www.silabs.com/products/development-tools/software/usb-
to-uart-bridge-vcp-drivers

* On macOS, after install, go to System Preferences > Security & Privacy > General > Allow ...

¢ On macOS 10.12.6 Sierra or higher, if above does not work, try this USB driver legacy version:
http://community.silabs.com/t5/Interface-Knowledge-Base/Legacy-OS-Software-and-Driver-
Packages/ta-p/182585

¢ Preferences > Additional Boards Manager URL:

Tan % xen0l

v Pages G

Find a page...

» Home

» Arduino

» Command Line Tools

v Feather Huzzah ESP8266
Buy
Code
Arduino

Setup (step-by-step)
Setup (for experts)
Language
Troubleshooting

Pinout

Resources

» Feather M4 Express

13
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Pinout

Note: the Particle Grove adapter needs this fix and this fix to work with the ESP8266.

 https://learn.adafruit.com/adafruit-feather-huzzah-esp8266/pinouts/ (.pdf)

i —=}

Tan % xen0l

» VS Code

+ Add a custom sidebar

Clone this wiki locally

https://github.com/tamberg/fhnw:
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Temperature & Humidity Sensor (DHT11)

Buy

* https://www.seeedstudio.com/Grove-Temperature-Humidity-Sensor-DHT1-p-745.html (~6$)

Pinout
Connect to Grove D<XY>

Color Signal
Black GND

Red VCC (3.3V)
White  NC

Yellow  SIG (Digital)
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Code

Arduino

ESP8266

e Library: Sketch > Include Library > Manage Libraries... > DHTesp > Install

¢ Example: File > Examples > DHT sensor library for ESPx > DHT_ESP8266
o In the example code, make sure to use DHT11

//dht.setup(..., DHTesp::DHT22);
dht.setup(..., DHTesp::DHT11);

nRF52840

e Library: Sketch > Include Library > Manage Libraries... > Grove DHT11 > Install

¢ Example: File > Examples > Grove Temperature and Humidity Sensor > DHTtester
o In the example code, make sure to use DHT11

//#define DHTTYPE DHT22
#define DHTTYPE DHT11

Python on Raspberry Pi

e Library: https://github.com/Seeed-Studio/grove.py

Recniirces

16
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< c @& https://classroom.github.com/classrooms/52782714-fhnw-iot-5ibb1 Q M % x « » 0O i

0 Classroom

Classrooms / FHNW iot (5ibb1)

FHNW iot (5ibb1)

fhnw-iot-5ibb1

Y¢ Assignments 20 Ay Students 0 ' TAs and Admins 1 83 Settings

Assignments

fhnw-iot-project-hs22

Group assignment for FHNW iot (5ibb1) Teams HS22 Invite link Z U

Q fhnw-iot-work-00 o N
Individual assignment Invite link + Z U

Q fhnw-iot-work-01 R
Invite link + Z U

Individual assignment
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< c & https://github.com/tamberg/fhnw-iot/issues/1#issuecomment-512249694

@ Closed Feather Huzzah ESP8266 doesn't work w/ Grove adapter #1

tamberg opened this issue on Feb 19, 2019 - 7 comments

i J tamberg commented on Jul 17, 2019 - edited ~ Owner | Author = =°-*

Here's a better fix, using a 100 kQ resistor:

l tamberg commented on Jul 17, 2019 Owner | | Author = *°*

And a pragmatic fix, which consumes a bit more energy, using a jumper cable:

18
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Take pictures

Reduce clutter.
Use good lighting.
Show how it works.

Always take one more.



o 4

= oS e s s P r_'.\q ¢ K
= 0. XL XY W OW XIS O Pug &y A€ 18y ({
pigMOI0  wem F . t







1 [
fay 0

O NMT O
AAAA
8000«

o
fi=)
r @

hzzyig/s34015 /W0D*S.
a/woohzzeup

inoxea4g £06Z/E£8HZNY

T

+ BNT

3U
——NC/VirL
I yhoy Gnd

CC BY-SA @tamberg



4

o\




25

CC BY-SA mitwelten.org




CC BY-SA mitwelten.org




Enable reuse

CCo 1.0 for example code.
MIT license for student projects, libraries.
CC BY-SA 4.0 for slides, pictures, designs, hardware, etc.

Use open source tools, e.g. Fritzing for layouts, OpenScad for designs.
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<« > C @ https://creativecommons.org/licenses/by-sa/4.0/

@creat“’e - Shareyourwork | Use&remix = WhatWedo Blog

©@OO

commons

Attribution-ShareAlike 4.0 International
(CC BY-SA 4.0)

This is a human-readable summary of (and not a substitute for) the license. Disclaimer.

You are free to:

gzculfurel
Share — copy and redistribute the material in any medium or < OVED FOR
format APFE /
Wor¥>

Adapt — remix, transform, and build upon the material
for any purpose, even commercially.

The licensor cannot revoke these freedoms as long as you follow the

license terms.
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@& https://creativecommons.org/publicdomain/zero/1.0/

creative

commons

‘ Share your work \ Use &remix | What We do

©@®

CCO0 1.0 Universal (CC0 1.0)
Public Domain Dedication

This is a human-readable summary of the Legal Code (read the full text). Disclaimer

No Copyright

wz’culfun?/
The person who associated a work with this deed has
dedicated the work to the public domain by waiving all of his APPE ;
or her rights to the work worldwide under copyright law, - Wo‘?

including all related and neighboring rights, to the extent
allowed by law.

You can copy, modify, distribute and perform the work, even
for commercial purposes, all without asking permission. See
Other Information below.

&

X mwx0@

Blog
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Choose an open source license

An open source license protects contributors and users. Businesses and savvy developers won'’t touch a project without this protection.

Which of the following best describes your situation?

P23

Ineed toworkina
community.

Use the license preferred by the
community you’re contributing to or
depending on. Your project will fit right in.

If you have a dependency that doesn’t have
a license, ask its maintainers to add a
license.

Iwant it simple and
permissive.

The MIT License is short and to the point. It
lets people do almost anything they want
with your project, like making and
distributing closed source versions.

Babel, .NET, and Rails use the MIT License.

I care about sharing
improvements.

The GNU GPLv3 also lets people do almost
anything they want with your project, except
distributing closed source versions.

Ansible, Bash, and GIMP use the GNU
GPLv3.

X a0 8§
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Home / Licenses

M IT Li ce nse Copy license text to clipboard

A short and simple permissive license with conditions only requiring preservation of copyright and
license notices. Licensed works, modifications, and larger works may be distributed under different Suggest this license

terms and without source code. Make a pull request to suggest this

license for a project that is not licensed.
Permissions Conditions Limitations Please be polite: see if a license has
already been suggested, try to suggest a

® Commercial use @ License and copyright notice @ Liability license fitting for the project's
@ Distribution @ Warranty community, and keep your
® Modification communication with project maintainers

friendly.
® Private use s

Enter GitHub repository URL

MIT License How to apply this license
Create a text file (typically named
Copyright (c) [year] [fullname] LICENSE or LICENSE.xt) in the root of
your source code and copy the text of
Permission is hereby granted, free of charge, to any person obtaining a copy the license into the file. Replace [year]
of this software and associated documentation files (the "Software"), to deal with the current year and [fullname] with

the name (or names) of the copyright
holders.

in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is Optional steps
furnished to do so, subject to the following conditions:

Add MIT to your project’s package
description, if applicable (e.g., Node.js,
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. . ® 1 watching
Things.Guide Resources —

Report repository
Things.Guide Resources is a collection of resources on Internet of Things (loT) and Embedded

Machine Learning.

Releases

About

No releases published
Create a new release
Things.Guide is maintained by a small group of applied science teachers trying to share open

course materials.

Packages
Wiki
No packages published
Publish your first package
The Wiki is a curated collection of links to things we wrote, used for teaching or find interesting.

¢ Wiki Home

loT

IoT connects physical things, small devices with sensors and actuators, to the Internet.

* |oT Resources Wiki Page

Embedded ML

Embedded ML allows physical things to learn from sensor input, through inference.

x z»0§
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= 0 things-guide / things-guide-resources

<> Code () Issues 9 Pullrequests () Actions [ Projects

Embedded ML

Thomas Amberg edited this page on May 16 - 114 revisions

Embedded Machine Learning Resources

Articles

Articles, blog posts, whitepapers, etc.

Tamw xzznx0g

Q Type /) to search i

0 wiki @ Security |~ Insights 8 Settings

v~ Pages e

Find a page...
> Home

v Embedded ML

¢ https://petewarden.com/2015/05/23/why-are-eight-bits-enough-for-deep-neural-networks/
* https://petewarden.com/2019/04/14/what-machine-learning-needs-from-hardware/

» https://ec.europa.eu/digital-single-market/en/news/ethics-guidelines-trustworthy-ai

Books

¢ https://www.oreilly.com/library/view/ai-at-the/9781098120191/
o https://www.oreilly.com/library/view/tinyml/9781492052036/
* https://www.manning.com/books/deep-learning-with-python

Articles
Books
Courses
Hardware
Papers
Platforms
Presentations
Projects

Tutorials

+ - |[|O]] 1) Q.’

Use Cases
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Thanks.

https://github.com/tamberg/fhnw-iot
https://twitter.com/tamberg

https://things.guide
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